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Above: Example of a 3-line authenticator 
Below: Example of a 2-line authenticator 

Mastering Windows V.1.2

Logging On: What's a BowNET? 

Windows: By Windows, we're referring to the Microsoft operating systems Windows 
'95, Windows '98, Windows  2000 and Windows XP. While these operating systems 
differ under the hood, 95% of what you'll see as a user in this session is identical. I 
will point out the differences as needed. 

BowNET: BowNET, is the name of the district wide computer network which connects 
all of the schools in the Bow School District together and to the rest of the world via 
the Internet. Our three buildings are physically linked via a fiber cables, and our three 
buildings are logically linked via a "server farm" which is located in my office. This 
server farm consists of ten file servers which all share a common database of users, 
passwords, and privileges. This database is known as a "Domain", and our "Domain" is 
BowNET. 

BowNET, the Domain, consists of a list of servers, workstations, files, and users which 
all interact with each other any time you do anything to any computer in any of our 
buildings. For example, student Joe Blow "logs in" to computer PC102 at Bow 
Elementary School. He logs into the Domain "BowNET" with his username "Joe Blow" 
and his current password, "******". All of this information travels over the network 
to Roy's office in the high school where one of the domain controllers (server) 
validates the user. Is there a BowNET user named Joe Blow who has permission to use 
PC102 at BES at this 
time of day with the 
password "******".  

If Joe is a valid user, 
the domain controller 
then informs the rest 
of the server farm 
where Joe is and what 
he has permission to 
access. The domain 
controller then lets 
the computer Joe is 
using "PC102" execute 
Joe's "Login Script". 
This script assigns 
drive letters to parts 
of the network that 
Joe has access to 
(i.e. H: for Joe's Home 
Directory).  



 2 

Depending on which version of Windows you are using, you may be presented with 
either a 3-line or a 2-line authenticator. Windows 9x should always be a 3-line, where 
you enter your username, your password, and your domain (Bownet). Windows 2000 
and Windows XP can present you with a 2 line authenticator. 

With a 2-line authenticator, your username must be a combination of your domain and 
your username, and both operating systems would be looking for your email address, 
i.e. jblow@bownet.org. You also have the option of pressing the “Option” button 
which presents you with the 3-line authenticator. 

Permissions to networked resources (files, programs, printers, etc.) are assigned to an 
individual's user name (Joe Blow) or by groups of individuals (Faculty). Important: 
When you "log in" to a computer, you give it (and anyone sitting at it) access to all 
network resources you have access to. That level of access remains until such time 
as you "log-off" of the 
computer. "Log Off" on 
a Windows machine is 
accomplished by going 
to the "Start Menu", 
selecting "Shut Down" 
and then selecting "log 
off?". Shutting down 
the computer, also logs 
you out of the 
network. 

Security 

File Security: When properly used, BowNET is a very secure (and safe) environment. 
All valuable files should be saved to your "Home Directory" (H:). Saving files to 
H: provides the following advantages:  

• Security: Files saved to your home directory are only accessible by you**, 
while files you save to the local computer "C:" are accessible by anyone who 
sits at the computer.  

• Availability: Files saved to your home directory are accessible within the 
district from any computer (Mac or PC) as well as remotely from home. Files 
saved to the local computer "C:" are accessible only from that computer.  

• Safety: All files saved on the server farm are backed up nightly onto DAT 
tapes. Even if the building burns to the ground, files saved to the server farm 
can be restored from tapes kept off-premise.  

** Please note that access to files is based on the following hierarchy: "Guest" 
on the bottom, followed by "Student", followed by "Faculty”, followed by 
“Administration”, followed by "Domain Administrators". Guest's can only access 
files, which are shared to "Everyone", "Students" can only access files in their 
own home directory, "Faculty" can access all "Student" folders, but only their 
own "Faculty" home directory. “Administrators" can access all folders. 
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Changing Your Password 

File security can be maintained by remembering to "log-in" and "log-out", not sharing 
passwords, regularly changing passwords and choosing appropriate passwords. Domain 
passwords are changed as follows:  

• Windows 2000/XP: 3-Finger Salute (Ctrl)(Alt)(Delete), and then click on 
"Change Password".  

• Windows '95 & '98: Go to "Start Menu", select "Settings", select "Control 
Panel", and double click "Passwords", select "Change Windows Password" and 
select "Microsoft Networking". Please note that this will immediately change 
your Domain password and the password for local access on that particular 
machine. Local access passwords will still have to be changed at each 
Window's 95/98 machine that you use.  

Please note that when you change your "Doma in" password, it affects all "Domain" 
resources such as e-mail, and Internet access. It does not affect non-domain 
passwords such as MMS2000 accounts or Personal folder encryption. 

Finding Networked Resources 

The "Log-In Script" which runs when you "log-in", automatically connects you to the 
network resources you are most likely to need. These "volumes" are available by 
opening the "My Computer" window. 

Example of a "Log-In Script":  

net use h: /home 
 
net use l: \\odyssey\clipmedia 
 
net use r: \\enterprise\readmore 
 
net use t: \\reliant\besmms2k 
 
net use v: \\defiant\WWNet 
 
net time \\odyssey /set /yes 
 
REM Microsoft Systems Management Server (start) 
REM SMS Build 1493 
 
call %0\..\smsls 
REM Microsoft Systems Management Server (end) 
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  Resulting "My Computer": 

If you wish to connect to 
additional networked volumes, 
or networked printers, you 
can do so through the 
"Network Neighborhood" 
a.k.a. “My Network Places”. 
"Double-Clicking" the desired 
computer will reveal its 
shared volumes and printers. 
"Double-Clicking" on a printer 
you have access to, will 
install that printer to your 
computer. "Double-Clicking" 
on a shared volume you have 
access to, will open the 
volume. You may also map an 
accessible volume to a drive 
letter by clicking on it with 
your right mouse button and 
selecting "Map Network 
Drive". 
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Saving Files: 

Students and Faculty should save all important files to the network. This is done 
by saving to the appropriate "sub-folder" on H:. Please note that Windows tries to 
save files to "My Documents" by default. Both of these directories are “usually” 
located on C: (local). 

 

Finding Files: 

One of the most important steps in "Saving files" is remembering where you saved 
them. Should you forget, you can search for a file using "wildcards" on any local or 
networked volume by clicking on it with the right mouse button and selecting "Find". 
For example, if looking for an Excel file on H:, you'd click on H: with the right mouse 
button and select 
"Find". In the "Named" 
field, you'd enter the 
wildcard symbol (*) 
followed by the suffix 
for excel files (.xls). 
"*.xls" This results in a 
listing of all excel files 
stored on sub-
directories you have 
access to on H:  

 



 6 

What's a GUI? 
GUI stands for Graphical User Interface, and it is a term for how the computer 
interacts with you as a user.  Windows is a GUI based on the concept of manipulating 
"windows". Thus a program runs in window. Data is copied from program to program by 
copying data from "window" to "window", etc… 

GUI Basics 
You will usually interact with your "windows" via a device held in your hand called a 
mouse. Moving the mouse left and right, or up and down results in the cursor on 
your screen moving left and right, or up and down.  

  
Programs and Files are represented on your computer screen via Icons. The mouse 
usually has two buttons. The left button is used most of the time and is used to 
select or activate the program or file represented by an icon. You can click once on 
an icon to select it, or quickly click it twice (Double Click) to activate the icon. The 
right button is used for secondary functions like calling up a program's properties.  
 
Example: 
l left click on the icon to select and move the icon 
l left double-click on the icon to run the program, open the 

file/folder 
l right click on the Outlook icon to change the program's properties 

Result of a “right-mouse-
button-click” 
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Using "Windows" 
You will normally Launch (run) a program by selecting its icon from the "Start Menu" 
(usually found in the lower left side of the screen). You could also launch a program 
by double-clicking on its icon or on a file associated with it. 
 
Once the program is running, you can move it's 
window by clicking on the "drag" bar which runs 
along the top of it's window. 
 
 
 

 
The 3 little boxes found on the top right hand corner of the drag bar are used to 
minimize, switch from windowed to full screen, or to quit the program or file running in 

the window. 
 
 
You can also maximize the size of a window by double-clicking on the drag bar. You 
can relocate a window's position on your screen by "dragging" it via its drag bar. If 
you "minimize" a window, you can restore it to its previous size by clicking on its 
"button" as seen on the "taskbar". 

 
You can also switch between multiple opened programs by clicking on their taskbar 
button or by pressing the "tab" key while holding down the "alt" key. 
 
You can also resize any window by clicking on an outside edge or corner and dragging 
it to the desired size. 
 
You exit a program by selecting “Exit” from the program’s Files Menu 
or by pressing (Alt)F4. 
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File Management  
 
Desktop 
When you first log into a Windows computer, the screen you end up at is the 
"desktop". On a typical machine the desktop might include icons for "My Computer", 
"Internet Explorer", "Outlook" (email), "Network Neighborhood", and more. You can 
customize the appearance of your desktop, save and open files, and run programs 
from it.  
 
Important: For security purposes, you should "save" files only to your home directory 
"H:". Your network home directory gives you the following 
advantages: 
• Security: Files on the network can only be access by users with 

proper credentials 
• Safety: Files on the network are backed up to DAT on a nightly 

basis. Any deleted or damaged files can be restored if Roy is 
notified within 5 days. 

• Access: any computer on our network (assuming user has proper 
credentials) can access files on the network 

 

My Computer 
If you open "My Computer", you will see all the "volumes" available for your use. These 
include both "local" and "networked" resources. 
l A: Floppy Disk (B:)  
l C: Hard 

Drive 
l D: CD-

ROM 
l H: Home 

Directory 
l Others 

are 
Network 
Resource
s which 
vary 
upon user 
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Saving from Programs 
Saving "files" is accomplished in the same manner for most programs. While the 
program is running, go to the "File Menu" and select "Save". Save (brings you to the 
File Requestor Window (first time only)).  

l “Save in” 
l “File Name” 
l “Save as Type” 

 

 
"Save As" (brings you to File Requestor Window) Use when you wish to change: 

l “Save in” location 
l “File Name” 
l “Save as Type” 

Opening from Programs 
Opening "files" is accomplished in the same manner for most programs. While the 
program is running, go to the "File Menu" and select "Open". "Open" brings you to 
the File Requestor Window. 

l “Look in” location 
l “File Name” 
l “Files of Type" 
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Using “My Computer” to Manage Files 
l Selecting Volumes 
l Selecting Folders (double click to open) 
l Folder Options: 

• Views: You can also change the way icons appear and are 
arranged in your folders by using the View menu. Viewing 
items as a list, includes additional information such as file size 
and creation dates.  

• Arrange allows you to sort files based on name, date, size, or 
kind (i.e. Word files vs Excel files, etc.) 

l Creating\Deleting Folders and Sub-Folders 
l Drag and Drop to Copy, Move, & Delete Files  
l Right Mouse Button and Properties to Copy, Move, & Delete Files  
l SEARCH 
 
Shortcuts: 
For programs you access regularly, you may want to create a shortcut 
to allow accessing it from locations other than the volume/folder it is 
installed in. To create a shortcut, click once on the program’s icon 
with the RIGHT mouse button and select “Create Shortcut” 
 
Using “Windows Explorer” to manage files 
l Hierarchy of Folders 
 
Accessing the Faculty Folder: 
With Windows 9x, H: is mapped to the network share 
\\enterprise\faculty. This was actually a bug in Windows 9x (H: 
should be mapped to teacher’s individual folder in that share). 
However, since we were stuck using Windows 9x for many years, 
folks got used to seeing the entire faculty folder in H:, and started 
using shared folders stored in Faculty. Then along comes Windows 
2000 and Windows XP which uses H: correctly. Now Joe Blow sees 
\\enterprise\faculty\jblow as H: and wonders how he can get at all 
that cool stuff in the “shared” folders. He can access it one of two 
ways; the easy way or the fast way: 
 
“My Network Places” a.k.a. the easy way:  

1) go to the Start Menu or your desktop and access “My Network 
Places” 

2)  if “Enterprise” isn’t already visable, click on “Entire Network” 
followed by a click on “Windows Network”. 

3) This displays all of our workgroups and domain. You should 
select “BowNET” 

4) Double Click on “Enterprise” to display all of it’s shares. 
5) Double Click on “Faculty” to open it and see all faculty folders 
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“Start Menu” a.k.a. 
the fast way: 
1) Goto the “Start 

Menu” and click 
on “Run” 

2) Type in 
\\enterprise and 
press “ok” to 
see all of it’s 
shares. 

3) Double click on 
faculty to open it and see all faculty folders 

 

 
Accessing the Student Folders: 
When students log into BowNET, their H: drives are mapped to a 
different folder on the Enterprise than the one used by faculty. 
However all Bow Faculty and Administration can access the student 
folders using the “My Network Places” method or “Start Menu” 
method listed above. However, instead of opening the “Faculty” 
folder, open the folder that matches up with the students “year of 
graduation”. Example, Joe graduates in 2011 so his folder is 
\\enterprise\2011. 
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Accessing Printers: 
There are at least 3 different ways that 
you can access a printer, and all 
require different instructions as 
follows: 
 
Direct Connect (lucky person has their 
own personal printer): The printer is 
directly attached to the computer you 
are using. To print, make sure that the 
printer is turned on, loaded with paper, 
and selected as the default printer for 
your computer. Press “print”. 
 
Peer to Peer Connect (the most 
common hookup for BowNET): In this 
scenario, the printer is a non-network 
personal printer as described above 
and it is attached to a computer other 
than the one you are using. However the computer it is attached to 
is sharing the printer. If your computer is already setup to print to a 
printer this way, simply make sure both the printer and the computer 
it is attached to are running and press “print”. If you need to get 
connected to a “peer-to-peer” printer, you’ll need to know the name 
of the computer the printer is attached to. Then you can either use 
the “My Network Neighborhood” or “Start Menu” methods described 
above to find the computer in question, and then double click on the 
icon that represents the printer it is sharing. If your computer and 
the computer that is sharing the printer, are both running the same 
operating system, this process is fairly painless. If you’re running 
two different operating systems, (ie. you have XP and they have 
Windows 98) things could get dicey and you’ll want to call in your 
building’s Technology Assistant. The common problems with the 
“peer-to-peer” connect are caused by the host computer or the 
printer not being on when you try to print. Do so, can result in a 
variety of problems. 
 

The black check indicates that 
the printer is the “default” 
printer. 



 13 

Network Printer (becoming more common): In this scenario, the 
printer is plugged into a network jack, not a computer. These printers 
tend to be far more reliable as they don’t depend on the host 
computer being on, etc… Ideally, you’d get your building’s Technology 
Assistanct to set up a “TCP/IP” port on your computer so that it 
directly connects to the network printer, however if you need to print 
“now”, there is a printer queue on the server \\galaxy which contains 
most of these network printers. To access the queue, use either the 
“My Network Neighborhood” or “Start Menu” methods described above 
to access \\galaxy . You should see the network printers listed here. 
Double click on the one you want to use. If you should ever 
encounter a network printer which isn’t listed in the Galaxy queue, 
please let Roy know and he’ll add it. 

 
 
Important Tips for all printer types: If you try to print a document, 
and nothing comes out, hitting print again is usually not a good idea. 
First, you should review the steps above to assure that you are 
printing to the correct printer, that it is on and loaded with 
paper/ink, and if it is connected to a different computer, make sure 
that computer is running. Too often, folks forget we’re a network and 
hit print a dozen times not knowing that they are printing to a 
different building. If you confirm all of the steps above but can’t print 
please contact your building’s Tech Assistant. Don’t keep pressing 
“print”. 
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Accessing eMail: 
To have complete access to our District email, you will need to use a 
computer with Outlook 2000 or higher installed (not to be confused 
with Outlook Express). In addition to Outlook, you’ll have to setup 
an Outlook Profile so the computer knows who you are and whose 
email you’re trying to read. This process is beyond the scope of this 
class, but you can visit http://www.bownet.org/fcc/Tutorials.htm for 
both handouts and a video on how to do so. You can also elect to 
attend a future Faculty Computer Club session on Outlook. Until 
then, you can access your email via the web with no additional 
software or setup required (FYI – This work from anywhere in the 
world that you have Internet access): 
 

1) Get on the Internet and goto http://mail.bownet.org/exchange  
2) You’ll be prompted with either a 2 line or a 3 line authenticator 

(see beginning of this handout) 
3) For 3 line authentication, username=username, 

password=password, and domain=bownet 
4) For 2 line authentication, username needs to be a combination 

of domain and username. In this case it would be 
“bownet\username”. Please note the direction of the “\” as the 
other one won’t work.  

 
Settings - Control Panel: Depending on the version of Windows you 
are using and the security policy for the computer you are using, the 
following control panels may or may not be available to you: 

• System 
• Display 
• Date and Time 
• Mouse 
• Sounds and MultiMedia 
• Passwords  
• Printers 
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Hot Keys to Know! 
There are certain keyboard shortcuts, which are universal to most Windows programs. 
These shortcuts are also know as "hot keys" and are usually indicated in a program's 
menu, right next to the related menu item.  

 

Some Common Hot Keys: 
l HELP: F1 
l Save: Ctrl+S 
l New: Ctrl+N 
l Open: Ctrl+O 
l Print: Ctrl+P 
l Select All: Ctrl+A 
l Cut: Ctrl+X 
l Paste: Ctrl+V 
l Copy: Ctrl+C 
l Undo: Ctrl+Z 
l Quit: Alt + F4 

 


